
TUTORIAL MANUAL

3 LOADING OF A SUCTION PILE

In this tutorial a suction pile in an offshore foundation will be considered. A suction pile is
a hollow steel pile with a large diameter and a closed top, which is installed in the seabed
by pumping water from the inside. The resulting pressure difference between the outside
and the inside is the driving force behind this installation.

In this exercise, the length of the suction pile is 10 m and the diameter is 5.0 m. An
anchor chain is attached on the side of the pile, 7 m from the top. The water depth at the
considered location is 50 m above the ground. The soil consists of clay but because of
the short duration of the load, an undrained stress analysis with undrained strength
parameters will be performed (Section 6.2 of the Reference Manual).

This exercise will investigate the displacement of the suction pile under working load
conditions. Four different angles of the working load will be considered. The installation
process itself will not be modelled. Only one symmetric half will be modelled. The
geometry for the problem is sketched in Figure 3.1.

Objectives:

• Using shape designer

• Using rigid body objects

• Undrained effective stress analysis with undrained strength parameters

• Undrained shear strength increasing with depth

• Copying material data sets

• Changing settings in Output

• Helper objects for local mesh refinements
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Figure 3.1 Geometry of the suction pile

3.1 GEOMETRY

An area of 30 m wide and 60 m long with half of the suction pile will be modelled in this
example. With these dimensions the model is sufficiently large to avoid any influence
from the model boundaries.
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Project properties

To define the geometry for this exercise, follow these steps:

• Start the Input program and select New project from the Create/Open project dialog
box.

• Enter an appropriate title for the exercise.

• Keep the standard units and set the model dimensions to xmin = -30 m, xmax = 30 m,
ymin = 0 m, ymax = 30 m.

• Click OK.

3.1.1 DEFINITION OF SOIL STRATIGRAPHY

In the current example only one horizontal soil layer is present. A single borehole is
sufficient to define it.

Create a borehole at (0 0 0). The Modify soil layers pops up.

• In the Modify soil layers window add a soil layer with top boundary at z = 0 m and
bottom boundary at z = -30 m.

• The water depth at the considered location is 50 m. This would imply that the head
is set to 50 m, but the results will be equal as long as the whole geometry is below
the water level (the water above the ground is a total load and not an effective load).
Hence, a head of 1.0 m is sufficient. Set the head to 1.0 m.

Open the Material sets window and create the data sets given in Table 3.1. In the
Parameters tabsheet deselect the Tension cut-off option in the advanced
parameters for strength. In this exercise, the permeability of the soil will not
influence the results. Instead of using effective strength properties, the cohesion
parameter will be used in this example to model undrained shear strength.
Advanced parameters can be entered after expanding the Advanced data tree in the
Parameters tabsheet.

Hint: The Interface data set can be quickly created by copying the 'Clay' data set
and changing the Rinter value.

• Assign the 'Clay' material data set to the soil layer and close the Material sets
window.

3.1.2 DEFINITION OF STRUCTURAL ELEMENTS

The suction pile is modelled in the Structures mode as half a cylindrical surface and this
is then defined as a rigid body.

Create a suction pile

In the Structures mode the suction pile as a rigid body will be defined. This is done by
creating a polycurve at the soil surface and extruding it downward.

Click the Create polycurve button in the side toolbar.
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Table 3.1 Material properties of the clay layer and its interface

Parameter Name Clay Interface Unit

General

Material model Model Mohr-Coulomb Mohr-Coulomb −
Drainage type Type Undrained B Undrained B −
Soil weight γunsat , γsat 20 20 kN/m3

Parameters

Young's modulus E ' 1000 1000 kN/m2

Poisson's ratio ν ' 0.35 0.35 −
Shear strength su,ref 1.0 1.0 kN/m2

Friction angle ϕu 0.0 0.0 ◦

Dilatancy angle ψ 0.0 0.0 ◦

Increase in stiffness E 'inc 1000 1000 kN/m2/m
Reference level zref 0.0 0.0 m
Increase in cohesion su,inc 4.0 4.0 kN/m2/m
Reference level zref 0.0 0.0 m
Tension cut-off − Inactive Inactive −
Interfaces

Interface strength − Manual Rigid −
Interface strength reduction Rinter 0.7 1.0 −
Initial

K0 determination − Manual Manual −
Lateral earth pressure coeff. K0,x , K0,y 0.5 0.5 −

• Click at (2.5 0 0) on the drawing area to define the insertion point. The Shape
designer window pops up.

Hint: From the Options menu, choose Visualization settings. Set the Intervals to 2,
while leaving the Spacing to 1 m. This allows to move the mouse with 0.5 m
interval.

• In the General tabsheet, the default option Free is valid for Shape.

• The polycurve is drawn in the xy-plane (Figure 3.2). Hence the default orientation
axes are valid for this example. For more information refer to Section 5.9.2 of
Reference Manual.

In the Segments tabsheet, click on the Add segment on the top toolbar.

• Set the Segment type to Arc, the Relative start angle to 90◦, the Radius to 2.5 m
and the Segment angle to 180◦ (Figure 3.3).

• Click OK to add the polycurve to the geometry and to close the Shape desginer.

Click on the created polycurve and select the Extrude object and set the z value to
-10 m.

• Right click the created surface, and select Create positive interface to create a
positive interface for the suction pile. Similarly create a negative interface for the
surface.

• Right click the polycurve and select Close from the appearing menu. Further, right
click the closed polycurve and select Create surface. This creates the top surface of
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Figure 3.2 General tabsheet of the Shape designer

Figure 3.3 Segment tabsheet of the Shape designer

the suction pile.

To create the suction pile, the Rigid body functionality is used. For more information on
Rigid bodies, refer to Section 5.8.8 of the Reference Manual.

• Right click the top surface and create a negative interface.
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• Select the Interfaces in the Model explorer. In the Selection explorer tree, select
Custom for the Material mode from the dropdown menu.

• Select Interface for the Material from the dropdown menu (Figure 3.4).

Figure 3.4 Interface material assignment in Selection explorer

• Multi-select the top and the curved surface. Right click on the selected surfaces and
select the option Create rigid body from the appearing menu (Figure 3.5).

Figure 3.5 Rigid body creation

• In the Selection explorer, set the reference point as (2.5 0 -7) for the rigid bodies by
assigning the values to xref , yref and zref .

• Set the Translation conditiony to Displacement, the Rotation conditionx and Rotation
conditionz to Rotation . Their corresponding values are uy = φx = φz = 0 (Figure
3.6).
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Figure 3.6 Rigid body in the Selection explorer

Create helper objects for local mesh refinements

A surface is created around the suction pile to achieve better mesh refinements. This is
done by creating a circular surface around the suction pile using the Shape designer.

Click the Create polycurve button in the side toolbar and click on (7.5 0 0) in the
drawing area.

• In the General tabsheet the default option for the shape (Free) and the default
orientation axes (x-axis, y-axis) are valid for this polycurve.

In the Segments tabsheet, click on the Add segment on the top toolbar. Set the
Segment type to Arc, Relative start angle to 90◦, Radius to 7.5 m and Segment
angle to 180◦.

Click Close polycurve from the top toolbar to close the polycurve.

• Click OK to add the polycurve to the geometry and to close the Shape desginer.

Click on the created polycurve and select the Extrude object and set the z value to
-15 m.

• Multi select the two created polycurves, right click and select Delete from the
appearing menu (Figure 3.7).

The geometry of the project is defined. A screenshot of the geometry is shown in Figure
3.8.
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Figure 3.7 Deleting the two created polycurves

Figure 3.8 Geometry of the suction pile

3.2 MESH GENERATION

In order to generate the mesh:

• Click on the Mesh tab to proceed to the Mesh mode.

• Hide the soil volume around the suction pile. Multi-select the suction pile, the
surface around the suction pile and the top surface of the suction pile.
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• In the Selection explorer set the value of Coarseness factor to 0.25.

The element distribution is Medium. Generate the mesh.

• Proceed to the Staged construction mode.

3.3 PERFORMING CALCULATIONS

The calculation for this exercise will consist of 6 phases. These are the determination of
initial conditions, the installation of the suction pile and four different load conditions. The
effect of the change of the load direction while keeping the magnitude unchanged will be
analysed.

• Click on the Staged construction tab to proceed with the definition of the calculation
phases. Keep the calculation type of the Initial phase to K0 procedure. Ensure that
all the structures and interfaces are switched off.

Add a new calculation phase and rename it as 'Install pile'.

• For this phase, we use the option of Ignore undrained behaviour.

• Activate all the rigid bodies and interfaces in the project.

Add a new phase and rename it as 'Load pile 30 degrees'.

• In the Phases window, check the Reset displacements to zero checkbox in the
Deformation control parameters subtree.

• Set the Solver type to Paradiso (multicore direct) to enable a faster calculation for
this particular project.

• In the Numerical control parameters subtree uncheck the Use default iter
parameters checkbox, which allows you to change advanced settings.

• Set the Max load fraction per step to 0.1.

• Click on the Rigid bodies in the Model explorer.

• In the Selection explorer tree, set Fx = 1949 kN and Fz = 1125 kN for the selected
rigid bodies.

• Define the remaining phases according to the information in Table 3.2. For each
phase select the Reset displacements to zero option and set Solver type to Pardiso
(multicore direct) and Max load fraction per step to 0.1.

The order of the phases is indicated in the Phases explorer (Figure 3.9). Calculation of
Phase_1 starts after the calculation of Initial phase is completed. The calculation of the
remaining phases starts after the calculation of the pile installation phase is completed.

Start the calculation process.

Save the project when the calculation is finished.

Table 3.2 Load information at the chain attachment point

Phase Start from phase Fx Fz

Load pile 30 degrees [Phase_2] Phase_1 1949 kN 1125 kN

Load pile 40 degrees [Phase_3] Phase_1 1724 kN 1447 kN

Load pile 50 degrees [Phase_4] Phase_1 1447 kN 1724 kN

Load pile 60 degrees [Phase_5] Phase_1 1125 kN 1949 kN
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Figure 3.9 Phases explorer

3.4 VIEWING THE RESULTS

To view the results:

• View the results of the last calculation phase. The deformed mesh of the whole
geometry will be shown. In particular, the displacements of the suction pile itself are
of interest.

Select the shadings representation and rotate the model such that the x−axis is
perpendicular to the screen.

• If the axes are not visible, select this option from the View menu. It is quite clear that
the point force acting on the pile does not disturb the displacement field locally
indicating that the pile is sufficiently thick here.

• In the same manner, the total displacements of the suction pile under a different
direction of the load can be inspected by selecting the appropriate phase from the
drop-down menu. In particular, Phase_2 is of interest, as in this phase the horizontal
part of the load will have the largest value (Figure 3.10).

Hint: As an alternative for true 3D finite element calculations, the online tool
SPCalc from XG-Geotools provides a quick solution for multiple bearing
capacity calculations of suction piles. For more information see
www.xg-geotools.com.
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Figure 3.10 Total displacement of the suction pile at the end of Phase_2
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